
 

 

Standard Edition -  

Diablo EZReporter Software 

Advanced Post-Run Reporting and Analysis 
for Chromatography Data Systems 

Copyright 2014, Diablo Analytical, Inc. 

 



 

 

 

Diablo Analytical EZReporter Software 

Standard Edition Reference Manual 
 

Copyright 2014, Diablo Analytical, Inc.  All rights reserved. 

 

This software and documentation are copyrighted by Diablo Analytical, Inc.  All other brands or 

product names are trademarks or registered trademarks of their respective owners. 
 

Diablo Analytical, Inc. 
5141 Lone Tree Way 

Antioch, CA  94531 

 

Phone:  925-755-1005 

Fax: 925-755-1007 

 

E-mail:  support@diabloanalytical.com 

Home Page:  www.diabloanalytical.com 

 
Manual Revision 20140214-1302 



 

 

DIABLO ANALYTICAL, INC. SOFTWARE LICENSE AGREEMENT AND LIMITED WARRANTY 

 

LICENSE AGREEMENT 

 

IMPORTANT:  Please carefully read the License Agreement below before installing the software.  The right to use this 

software product is sold only on the condition that the customer agrees to the following license.  INSTALLING THE 

SOFTWARE INDICATES YOUR ACCEPTANCE OF THESE TERMS AND CONDITIONS. 

 

In return for payment of the one-time license fee for this software product, Customer receives from Diablo Analytical, 

Inc. (Diablo) a license to use the product subject to the following terms and conditions: 

 

Use:  The product may be used one computer or workstation.  A separate license agreement and fee is required for each 

additional computer or workstation on which the product is used.  Customer may not reverse assemble, decompile, or 

modify the software. 

 

Copies:  The software product may not be duplicated or copied except for archive purposes, program error verification, 

or to replace defective media, and all copies made must bear the copyright notices contained in the original. 

 

Ownership:  Purchase of this license does not transfer any right, title or interest in the software product to Customer 

except as specifically set forth in this License Agreement.  Customer is on notice that the software product is protected 

under copyright laws. 

 

Transfer of  Rights:  This license and the software product may be transferred to a third party, with prior written consent 

from Diablo, provided the third party agrees to all the terms of this License Agreement and the Customer does not retain 

any copies of the software product. 

 

Sublicensing and Distribution:  Customer may not sublicense the software or distribute copies of the software to the 

public in physical media or by telecommunication without the prior written consent of Diablo. 

 

Termination:  Diablo reserves the right to terminate this license upon breach.  In event of termination, Customer will 

either return all copies of the product to Diablo, or with Diablo's prior consent, provide Diablo with a certificate of 

destruction of all copies. 

 

Updates and Upgrades:  Customer agrees that the software does not include updates and upgrades which may be 

available from Diablo in a separate support agreement. 

 

Export Restrictions:  Customer agrees not to export or re-export the software or any copy in violation of the U.S. Export 

Administration regulations or other applicable regulation. 

 

LIMITED WARRANTY 

 

Limited Warranty:  Diablo warrants that the original disks are free from defects for 90 days from the date of delivery of 

the software. 

 

No Other Warranties:  To the maximum extent permitted by applicable law, Diablo expressly disclaims any warranty for 

the software product.  The software product and any related documentation is provided "as is" without warranty of any 

kind, either express or implied, including, without limitation, the implied warranties or merchantability of fitness for a 

particular purpose.  The entire risk arising out of use or performance of the software product remains with the customer. 

 

Limitation of Liability and Customer Remedies:  Diablo's entire liability and the customer's exclusive remedy under this 

license agreement shall be, at Diablo's option, either (a) return of the price paid for the software or (b) replacement of the 

software that does not meet Diablo's Limited Warranty and which is returned to Diablo with a copy of the customer's 

receipt.  Any replacement software will be warranted for the remainder of the original warranty period, or 30 days, 

whichever is longer.  These remedies are not available outside the United States of America. 

 



 

 

No Liability for Consequential Damages:  To the maximum extent permitted by applicable law, in no event shall Diablo 

be liable for any damages whatsoever (including, without limitation, damages for loss of business profit, business 

interruption, loss of business information, or any other pecuniary loss) arising out of the use or inability to use the 

product, even if Diablo has been advised of the possibility of such damages.  Because some states/jurisdictions do not 

allow the exclusion or limitation of liability for consequential or incidental damages, the above limitation may not apply 

to you. 
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Introduction 

EZReporter Software Overview 

Advanced Post-run Reporting and Analysis for Chromatography Data 
Systems. 

EZReporter is a flexible, advanced post-run analysis and reporting solution for a 

number of supported chromatography data systems. 

 
The Diablo Analytical EZReporter Software 

The EZReporter software includes a base reporting module and three optional 

modules: a Natural Gas Analysis (NGA) calculation and reporting module, a Results 

Database module, and an Analog & Digital Output module used with the National 
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Instruments Compact FieldPoint hardware.  These modules are combined in several 

different “Editions” of the EZReporter software. 

 

EZReporter Edition Modules Included 

Standard Edition Base Module Only 

Natural Gas Analysis Edition Base and Natural Gas Analysis Modules 

Results Database Edition Base and Results Database Modules 

NGA Database Edition Base, NGA, and Results Database Modules 

Analog and Digital Output Edition Base and Analog & Digital Output Module 

The Base Module is required for all Editions of the software.  You can also license 

and activate individual Modules at a later time if your needs change.  The features 

included in each module are summarized below. 

Base Software Module 

The Base software module can be licensed by itself or you can add one or both of the 

optional modules.  The features present in the base module include: 

 Process Results Automatically from supported chromatography 

data systems 

 Multi-Channel Reporting: Results from multiple detector channels 

can be combined into a single report with both raw and normalized 

amounts displayed. 

 Easily Updated and Customized:  The component list is completely 

customizable.  Components can be added to or deleted from the 

component list. 

 Data Export: Results can be exported to a text file for transfer to a 

Laboratory Information Management System (LIMS), Process Control 

System, or even Microsoft Excel.  The format of the text file can be 

easily customized using EZReporter’s flexible Export Templates. 

 Monitor Specific Results:  You can set up both component and 

calculated results as monitored parameters that are displayed in a 

separate monitoring window. 

 High and Low Alarms:  You can set both high and low alarm limits 

for monitored parameters. 

 Trend/History Plots:  You can plot the historical value of any of the 

monitored parameters.  The trend plot can be printed, copied to the 

Windows clipboard, and the historical data can be exported to a 

comma-delimited text file. 

 Include Results from Other Analyzers:  The component list can be 

configured so that results from other analyzers can be entered manually 

for specified components and included in the reports. 

 

Optional Natural Gas Analysis Module 

The optional Natural Gas Analysis (NGA) module is designed to perform Natural 

Gas / Refinery Gas / Natural gas Liquids (NGL) heating value and related 

calculations.  The results from these calculations are available for reporting, 

monitoring, trend plotting, and exporting through the base module.   The features 

present in the NGA module include: 
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 Standard GPA/ASTM/ISO Calculations:  Calculates 

Dry/Saturated/Wet Gross and Net Heating Value, Real Relative 

Density, Gas Compressibility factor, GPM value, Wobbe Index, and a 

large number of other results using GPA 2172-09, 2177-03, 2186-02, 

ASTM D2598-02 (vapor pressure and relative density), and ISO 6976 

standard calculations. 

 Physical Properties can be Easily Customized:  The component list 

is completely customizable.  Components can be added to or deleted 

from the component list, and calculation factors (Heating Value, Molar 

Mass Ratio, Summation Factor, and GPM Volume Factor, etc.) can be 

updated by the user as needed. 

 Standard Physical Property Tables:  Standard component physical 

property tables are provided for: 

 the GPA 2145-03 and GPA 2145-09 Standards 

 the GPSA Engineering Data Book (12th Edition, 2004) 

 the ASTM D3588-98 (2003) standard 

 the GPA TP-17 Standard 

 the ASTM D2598-02 (2007) standard (vapor pressure and relative 

density) 

 the ISO 6976 Standard 

Optional Results Database Module 

The optional Results Database module allows you to capture results and save them in 

a local SQLite database.  A few of the capabilities of the Results Database are listed 

below. 

 Local “Zero Configuration” Database:  Sample results including 

sample information, individual component results, and calculated 

natural gas analysis (NGA) results can be added automatically to a 

local results database. 

 Search for Results:  You can search the results database for historical 

results by Sample Name or Results ID.  Results can be filtered further 

by Injection or Report Date and Results or Export Status. 

 Batch Processing:  You can batch reprocess multiple results from the 

database.  Reprocessing options include printing reports, exporting 

results, and trend-plotting results. 

 Statistical Analysis:  Statistics including average, standard deviation, 

%RSD, maximum, and minimum are calculated and displayed when 

performing sample name searches. 

 Compare Results: A results comparison window can be used to 

compare the component normalized mole% values between two 

samples using either the GPA 2261 repeatability or reproducibility 

limits (or any other limits entered by the user). 

 Track Result Status:  Each result in the database has a “Status” field 

that can be set to “None”, “Accept”, or “Reject” status.  The status field 

can then be used in searches or batch reprocessing to filter which 

results are selected. 

 Import Results:  You can import results into the Results Database 

from comma- or tab-delimited text files. 
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Optional Analog and Digital Output Module 

The EZReporter Analog and Digital Output Module allows you to generate 

analog/signal outputs and digital/alarm outputs based on Monitored Parameter results 

using National Instruments Compact FieldPoint I/O hardware.  See the Analog and 

Digital Output Module Quick Start Guide for information on the Compact FieldPoint 

hardware requirements and the capabilities of this optional module. 

Notes for BTU Calculator Users 

The Diablo EZReporter Software is the next-generation of the Diablo BTU 

Calculator Software.  The EZReporter Natural Gas Analysis (NGA) Edition is the 

direct replacement for the BTU Calculator software.  Existing licenses of the BTU 

Calculator can be upgraded to the EZReporter NGA Edition. 

System Requirements 

The software is designed for operation under the Microsoft Windows 7 Professional 

and Windows XP Professional operating systems.  See the EZReporter Quick Start 

Guide for your chromatography data system for any special requirements. 

 

Important: Important:  It is the customer’s responsibility to set up the Gas Chromatograph and 

chromatography data system so that calibrated peak results are produced from the 

analysis. 

 

Installing the Software 

To install the software, simply run the installation program that was downloaded 

from our web site or provided on the installation CD-ROM.  Follow the directions 

presented by the installation program.  The installation program will install the 

Diablo EZReporter in trial mode on new systems, or will update licensed 

installations to the latest version of the software. 

 

Important: Important:  You must be logged in to an account with Administrator privileges in 

order to install the software. 

Important:  Any users who will be running the software under a non-administrator 

account must have full read/write permissions to the EZReporter directories and 

files.  The installation program grants these rights to the “Everyone” user group.  

However, if the “Everyone” user group is disabled on the network, then you will 

have to grant these permissions manually. 

 

 

Installation Paths and Folders 

The EZReporter software is installed to the folder, 

“C:\Program Files\Diablo EZReporter” (Win XP and Win 7-32 bit) 

“C:\Program Files (x86)\Diablo EZReporter” (Win 7-64 bit) 

EZReporter configuration and template files are saved in the “Settings” folder, 
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“C:\Program Files\Diablo EZReporter\Settings” (Win XP and Win 7-32 bit) 

“C:\Program Files (x86)\Diablo EZReporter\Settings” (Win 7-64 bit) 

EZReporter data files are saved by default in the “Data” folder, 

“C:\Program Files\Diablo EZReporter\Data” (Win XP and Win 7-32 bit) 

“C:\Program Files (x86)\Diablo EZReporter\Data” (Win 7-64 bit) 

Upgrading from the Diablo BTU Calculator 
Software 

The EZReporter Natural Gas Analysis (NGA) Edition replaces the BTU Calculator 

software and can read existing BTU Calculator configuration and data files directly. 

The EZReporter installer doesn't touch an existing BTU Calculator installation - the 

two programs can be installed and run on the same computer. 

Automatic Import of Configuration and Template Files 

The first time you start EZReporter, the software will attempt to import any custom 

(non-default) configuration or export template files from the BTU Calculator 

installation folder.  It will also edit the imported configuration files so that the default 

data directory and/or export directory no longer point to their old location in the 

BTU Calculator folder structure (if that is where they were set).  The original files 

are not modified by the import procedure. 

Configuration and template files are now kept in the "Settings" folder under the 

EZReporter installation folder in order to reduce clutter in the main installation 

folder and make it easier to find these files. 

Changes to Chromatography Data System Methods 

You may need to update your chromatography data system methods in order to have 

them use EZReporter instead of the BTU Calculator for automatic processing.  See 

the EZReporter Quick Start Guide for your data system for more information. 

Software License and Registration 

The EZReporter software is distributed as a fully functional 30-day trial application.  

The trial version has all of the features of the registered version, but you will be 

reminded that you are running the trial version with a “nag” screen each time you 

start the software.  At the end of the 30-day trial period the application will no longer 

start unless you purchase a license or request an evaluation extension from Diablo 

Analytical. 

 

Important: Important:  The Results Database, Natural Gas Analysis (NGA), and Analog & 

Digital Output Modules are add-on options that require payment of additional license 

fees and require separate license activation codes (unless they are included in the 

particular software edition that you have licensed).  However, you can evaluate these 

features during the 30-day trial period of the base software.  If you activate the base 

software without also activating the optional module, then those features from the 

un-activated module will be disabled. 
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Activating your License 

Please refer to the Diablo Software License Guide for information on how to activate 

the base EZReporter module or any of the optional modules.  This guide can be 

accessed through the “Help” button on the License Status window that is displayed 

when you start the software or by selecting the “License Status” option of the “Help” 

menu.  An Adobe Acrobat (PDF) version of the guide is also saved in the 

EZReporter installation folder. 

 
The EZReporter “License Status” window used to activate the software. 

Technical Support 

The Diablo EZReporter software was written and is supported by: 

Diablo Analytical, Inc. 
5141 Lone Tree Way 

Antioch, CA  94531 

Phone:  (925) 755-1005 

Fax:    (925) 755-1007 

 

Phone 

If you want to speak directly with technical support, call us at (925) 755-1005. 

 

Fax 

Fax a description of your problem or suggestion to us at (925) 755-1007. 

 

Electronic Mail 

Use our dedicated support address for e-mail based technical support: 

support@diabloanalytical.com 
 

World Wide Web 

mailto:support@diabloanalytical.com
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Use our web-based help desk to submit and track support requests:  

http://www.diabloanalytical.com/support.htm 

http://www.diabloanalytical.com/support.htm
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Getting Started 

The Sample Results Window 

After starting the software, the following window is displayed.  This window shows 

the “Sample Results” tab containing the results of the last analysis (but will be blank 

when the software is first started). 

 
The “Sample Results” tab on the Main Screen of the Diablo EZReporter Software 

Sample Information 

This section of the main screen contains the sample information that was passed to 

the software from the chromatography data system, or was entered by the user during 

manual processing.  You can also define custom sample information fields if you 
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would like to include additional data in the report.  See “Sample Info” on page 27 for 

more information on this capability. 

Note:  Blank sample information fields are not displayed in the sample Information 

table. 

Component Summary 

This section contains a summary of the individual component results including, 

 Component Peak Retention Time 

 Component Peak Area  

 Component Raw Amount 

 Component Normalized Amount 

Results Summary 

The calculation results are displayed in this section of the main screen.  Results 

displayed include, 

 Total un-normalized Amount 

 Total Normalized Amount 

Customizing the Report 

You can customize the report window by choosing which results to display, and 

what labels to use to describe each result. See “Report - Control” on page 23 for 

more information. 

The Parameter Monitor Window 

This window shows the Parameter “Monitor” tab that displays the results from the 

last analysis for any monitored parameters.  High and low alarm limits can be set up 

for each monitored parameter.  See “The Parameter Monitor” on page 42 for more 

information on this capability. 
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The “Parameter Monitor” tab on the main screen of the Diablo EZReporter 

The Parameter History Window 

This window shows the Parameter History tab that can be enabled to plot the 

historical values of any of the monitored parameters.  See “Parameter History” on 

page 42 for more information on this capability. 
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The “Parameter History” tab on the main screen of the Diablo EZReporter Software. 

Quick Start Instructions 

The following instructions describe the key steps that should be performed when 

using the software for the first time.  You will find more detailed instructions in later 

sections of this manual. 

Load and Edit the Configuration File 

The first time you run EZReporter the following window will be displayed allowing 

you to choose the default configuration file you would like to load: 
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Choose the default configuration that most closely matches your application or 

browse for a specific configuration file.  Once you have loaded the configuration file, 

you should configure the settings for your application.  To open the configuration 

editor, select the "Edit Configuration.." option of the "Tools" menu. 

Additional information about configuring the software can be found in "Configuring 

the Base Software" on page 19.  The default configuration files shipped with the 

software are listed in the following table. 

 

Important Important:  If you upgrade or re-install the EZReporter Software, all of the default 

configuration files listed in this table will be overwritten with the current versions.  

Consequently, if you use any of these default configuration files as the basis for a 

custom configuration, make sure to save your configuration file with a different file 

name. 

 

 

EZReporter Standard Configuration Files 

File Description 

Default Configuration Files 

STD Default.cfg The default configuration for standard/non-natural gas 

analysis applications.  It does not include any pre-

configured components.  You will need to add the 
components required for your analysis. 

NGA Default A default configuration for natural gas analysis 

applications (GPA 2172/2145 analysis with C1-C10 

components).  The Pressure Base is set to 14.73 in this 
file. 

C6+ Default.cfg An alternate configuration for natural gas analysis 

applications (GPA 2172/2145 analysis with C1-C6+ 

components)..  The calculation factors used for the 

hexanes plus component are based on a 60:30:10 

mixture of hexane, heptane, and octane.  The GPA 

2145-09 Standard was used to calculate the Hexanes+ 

calculation factors. 
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EZReporter Standard Configuration Files 

File Description 

ISO Default.cfg A default configuration for natural gas analysis 

applications (ISO 6976 analysis).  The physical 

property data are for a combustion temperature of 15 
Deg. C and a metering temperature of 15 Deg. C. 

ISO 6976 (0-0 Deg C).cfg Similar to the ISO Default configuration except the 

physical property data are for a combustion temperature 

of 0 Deg. C and a metering temperature of 0 Deg. C. 

ISO 6976 (15-0 Deg C).cfg Similar to the ISO Default configuration except the 

physical property data are for a combustion temperature 
of 15 Deg. C and a metering temperature of 0 Deg. C. 

ISO 6976 (25-0 Deg C).cfg Similar to the ISO Default configuration except the 

physical property data are for a combustion temperature 

of 25 Deg. C and a metering temperature of 0 Deg. C. 

ISO 6976 (15-15 Deg C).cfg Identical to the ISO Default configuration with a 

combustion temperature of 15 Deg. C and a metering 

temperature of 15 Deg. C. 

ISO 6976 (205-20 Deg C).cfg Similar to the ISO Default configuration except the 

physical property data are for a combustion temperature 
of 20 Deg. C and a metering temperature of 20 Deg. C. 

ISO 6976 (25-20 Deg C).cfg Similar to the ISO Default configuration except the 

physical property data are for a combustion temperature 
of 25 Deg. C and a metering temperature of 20 Deg. C. 

NGL Default (WtPct-

Combined).cfg 

A default configuration for Natural Gas Liquids (NGL) 

with “combined” extended fraction reporting.  With this 

calculation and reporting method the extended fraction 

results are reported separately and are also combined 

into the standard /total results through the specified 

combined component (usually Hexanes Plus).  This 

configuration includes the full component list from 

GPA TP-17 and GPA 2145-09. 

NGL Default (WtPct-Combined-

Corrected).cfg 

A default configuration for Natural Gas Liquids (NGL) 

with “combined” extended fraction reporting.  This 

configuration file is the same as the “Combined” 

configuration, but it is also set up to correct the raw 

component amounts in the extended fraction using a 

correction (“bridge”) factor calculated from the iso-

pentane and n-pentane amounts from the standard 

component range (usually from the TCD detector) and 

the extended component range (usually from the FID 

detector). 

NGL Default (WtPct-

Separate).cfg 

A default configuration for Natural Gas Liquids (NGL) 

with “separate” extended fraction reporting. With this 

calculation and reporting method, the extended fraction 

results are reported separately from the standard/total 

results.  This configuration includes the full component 

list from GPA TP-17 and GPA 2145-09. 

GPA 2145-03.cfg Contains the components and factors in the GPA 2145-

03 Standard.  The Pressure Base is set to 14.696 in this 
file. 

GPA 2145-09.cfg Contains the components and factors in the GPA 2145-

09 Standard.  The Pressure Base is set to 14.696 in this 
file. 
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EZReporter Standard Configuration Files 

File Description 

GPA 2177-03.cfg A configuration based on the GPA 2177-03 standard.  

The pressure base is set to 14.696 in this file. 

ASTM D3588-98 (2003).cfg Contains a sub-set of the components and factors in the 

ASTM D3588-98 (2003) standard.  The Pressure Base 
is set to 14.696 in this file. 

Refinery Gas.cfg A configuration containing common components found 

in refinery gas.  Physical properties are taken from GPA 

2145-09, ASTM D3588 (98), GPSA Engineering Data 

Book (2004) and other sources. 

Calculation Check Configuration Files 

GPA 2172-09 Calculation Check 

at 14.696 psia.cfg 

A configuration designed to check the GPA 2172-09 

NGA calculations made at a bas pressure of 14.696 

psia.  Simply load the corresponding data file (GPA 

2172-09 Example Data at 14.696 psia.btu) and switch 
to the “Parameters” table. 

GPA 2172-09 Calculation Check 

at 14.65 psia.cfg 

Same as above except it is designed to check the 

calculations at a bas pressure of 14.65 psia.  Make sure 

to load the correct data file (GPA 2172-09 Example 
Data at 14.65 psia.btu) 

GPA 2177-03 Calculation Check 

(VolPct).cfg 

A configuration designed to check the GPA 2177-03 

calculations made at a baes pressure of 14.696 psia.  

Simply load the corresponding data file (GPA 2177-03 
(VolPct).btu) and switch to the “Parameters” table. 

GPA 2186-02 Calculation Check 
(MolPct-Separate).cfg 

A configuration designed to check the GPA 2186-02 

NGL calculations using the Mole% component amounts 

and separate extended fraction report.  Simply load the 

corresponding data file (GPA 2186-02 Calculation 

Check (MolPct-Separate).btu) and switch to the 
“Parameters” table. 

GPA 2186-02 Calculation Check 

(WtPct-Combined).cfg 

A configuration designed to check the GPA 2186-02 

NGL calculations using the Weight% component 

amounts and combined extended fraction report.  

Simply load the corresponding data file (GPA 2186-02 

Calculation Check (WtPct-Combined).btu) and switch 
to the “Parameters” table. 

GPA 2186-02 Calculation Check 

(WtPct-Separate).cfg 

A configuration designed to check the GPA 2186-02 

NGL calculations using the Weight% component 

amounts and separate extended fraction report.  Simply 

load the corresponding data file (GPA 2186-02 

Calculation Check (WtPct-Separate).btu) and switch to 

the “Parameters” table. 

ISO 6976 Calculation Check.cfg A configuration designed to check the ISO 6976 NGA 

calculations.  Simply load the corresponding data file 

(ISO 6976 Calculation Check.btu) and switch to the 
“Parameters” table. 
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Important: Hint:  The order of the components in the component settings table is the order that 

they will be printed in the report.  You can easily rearrange the component order by 

first selecting a component's row in the table by left clicking on that row with the 

mouse.  Next, while the cursor is still pointing to that row, click and hold the right 

mouse button and drag the component to a new location in the table.  The row being 

moved will be highlighted in red.  Release the right mouse button when the 

component is located at the desired position in the table. 

Important:  Be careful rearranging the order of components if you are using 

Calculated Results or Export Templates that refer to component results.  In those 

instances components are identified by a component index, which is the order of the 

component in the component table.  If you rearrange the component table after you 

have set up a Calculated Result or Export Template, it is possible that the wrong 

component will be referenced. 

 

Set the Report Preferences 

Modify the report titles as desired.  In addition, check "Print report for automatically 

processed results" if you would like a report to be printed automatically when the 

software generates a report upon receiving and processing results from the 

chromatography data system.  The report will be printed to the default printer. 

Set the Data File Preferences 

Specify the directory into which you would like to save EZReporter data files – use 

the "Browse" button to select or create the desired directory (see “Data Files” on 

page 26). 

Automatic file saving 

Check this box if you would like to have a data file created in the default data 

directory during automatic processing of data from the chromatography data system.  

The data files are named using a date + time format: 

 YYYYMMDD-HHMMSS.BTU  

Where YYYYMMDD is the current date and HHMMSS is the current time (e.g. 

20050208-153423.BTU). 

File Naming Options 

Check this box if you would like to have the sample name added to the Date+Time 

formatted file name during automatic processing.  If you enable this option, then you 

can also choose whether to add the sample name before (e.g. NGA Sample-

20050208-153423.BTU) or after (e.g. 20050208-153423- NGA Sample.BTU) the 

file name. 

Set up your Chromatography Data System 

Follow the instructions in the EZReporter Quick Start guide to set up your 

chromatography data system to send results automatically to EZReporter for 

processing.  The Quick Start Guides can be found on the installation CD, or can be 

accessed via links in the Diablo EZReporter program group. 
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Running the Software 

The Main Menu 

The Diablo EZReporter is configured and controlled using the following menu 

options: 

File Menu 

New Data File 

Select this option to create a new data file and manually enter mole percent data.  See 

"Data Processing and Reporting" on page 44 for more information on this capability. 

Open Data File… 

Select this option to open an existing EZReporter data file saved on disk. 

Save Data File As… 

Select this option to save the current data and results to an EZReporter data file. 

Export Current Results 

Select this option to export the current results to a text file using the settings 

specified in the Export section of the current configuration. 

Load Configuration… 

Select this option to load a configuration file from disk.  This is a shortcut to opening 

the configuration editor and pressing the "Load" button. 

Sample-Specific Configurations… 

Select this option to enable the use of sample-specific configuration files when 

processing results automatically from a supported data system.  See “Sample-

Specific Configuration Processing” on page 45 for more information. 

Print 

This menu option allows you to print either the results that are currently displayed in 

the main screen (Print > Report), or the current settings being used by the software 

(Print > Current Settings). 

The “Print > Report” menu option allows you to send the report to either the printer 

(Print > Report > Send to Printer) or save it to an Adobe PDF file (Print > Report > 

“Save as PDF). 
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The “Print > Parameter History Plot…” menu option allows you to print the trend 

plot and summary statistics for the parameter currently selected in the Parameter 

History window. 

Print Setup… 

This option allows you to configure the printer. 

Exit 

This option immediately closes the software. 

Tools Menu 

Edit Configuration… 

This option displays the EZReporter Configuration Dialog box.  See "Configuring 

the Base Software" on page 19. 

Backup Current Configuration Files... 

This option backs up the current EZReporter configuration and log files into a single 

“Zip” archive file and optionally allows you to copy the file to a flash drive or other 

backup location.  The file is named, ‘ezrbackup-yyyymmdd-hhmmss.zip’, where 

‘yyyymmdd’ is the current year month and day, and ‘hhmmss’ is the current hour, 

minute, and second of the day.  The file is created in the EZReporter installation 

folder. 

Edit Current Data Set… 

This option allows you to re-edit manually entered data sets.  It is not available when 

an automatically processed data set from a chromatography data system is loaded.  

See "Data Processing and Reporting" on page 44. 

Show Export Template Variables… 

Displays a table of the “variables” that can be used in an export template file.  See 

the Appendix for more information about Export Templates. 

Help Menu 

Help Contents… 

Displays the contents page of the Diablo EZReporter help file. 

View Release Notes 

Opens the current release notes (readme.txt).  The release notes document the latest 

changes and enhancements to the software that may not have made it into this 

document. 

License Status… 

Displays the current license status of the Diablo EZReporter software.  This menu 

option is not displayed in versions of the software that were purchased under a site 

license. 

About Diablo EZReporter… 

Displays support and version information about the Diablo EZReporter. 
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Configuring the Base Software Module 

The software is configured using the "Diablo EZReporter Configuration" window, 

which is displayed by selecting the "Edit Configuration.." option of the "Tools" 

menu.  Note that this dialog box is resizable. 

 
The Diablo EZReporter Configuration Window. 

Managing Configuration Files 

You can Load and Save configuration files using the "Load and "Save" buttons.  The 

“Save As” button allows you to save the current configuration to a new file.  

Configuration files are saved by default in the Diablo EZReporter installation 

directory.  You can also print a settings report using the "Print" button. 

 

Important Important:  If you upgrade or re-install the EZReporter Software, all of the default 

configuration files will be overwritten with the current versions.  Consequently, if 

you use any of the default configuration files as the basis for a custom configuration, 

make sure to save your configuration file with a different file name. 

 

Components 

The components "tab" of the configuration dialog is used to manage the list of 

components that will be included in the calculations and report.   
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The "Components" tab of the Diablo EZReporter configuration window. 

Component Name 

The component names entered in the components table will be displayed in the 

component summary tables and reports. 

 

Important: Important:  If you are going to be processing data from a chromatography data 

system, then you must make sure that the names in the EZReporter component table 

match the names in the chromatography data system calibration/report exactly. 

 

Manual Amount/Mole% Entry 

Check this box if you are using the software to generate reports automatically from a 

chromatography data system, and you need to be able to enter the specified 

component mole percent based on the results of a separate analysis.   

When results from the data system are processed, a dialog box will be displayed, 

allowing you to enter the component's un-normalized amount or mole%, which will 

then be included in subsequent calculations. 

Adding new components 

Press the "Add" button to add a new row to the component table manually.  The row 

will be added below the currently selected row. Enter the component name and 

calculation factors for the new component. 

Deleting existing components 

To delete a component from the component list, select the row containing the desired 

component and press the "Delete" button". 
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Changing the component order 

The order of the components in the component settings table is the order that they 

will be printed in the report.  You can easily rearrange the component order by first 

selecting a component's row in the table by left clicking on that row with the mouse.  

Next, while the cursor is still pointing to that row, click and hold the right mouse 

button and drag the component to a new location in the table.  The row being moved 

will be highlighted in red.  Release the right mouse button when the component is 

located at the desired position in the table. 

 

Important: Important:  Be careful rearranging the order of components if you are using 

Calculated Results or Export Templates that refer to component results.  In those 

instances components are identified by a component index, which is the order of the 

component in the component table.  If you rearrange the component table after you 

have set up a Calculated Result or Export Template, it is possible that the wrong 

component will be referenced. 

 

Clearing the table 

Press the “Clear” button to delete all components from the component table. 

Undoing changes to the component list 

Press the “Undo” button to return the component list to the last saved configuration. 

Component Table Context Menu 

The following context menu will pop up when you right click with the cursor 

anywhere in the component table: 

Add new component below:  Clicking this option will result in a new blank line 

being added to the component table directly below the currently selected line. 

Clone selected component below:  Clicking this option will result in a new line 

being added to the component table directly below the currently selected line.  All of 

the component physical property data and other settings will be copied from the 

selected component.  The cloned component name will have a “*” appended to it as 

a reminder that you need to rename it (duplicate component names are not allowed). 

Delete selected component:  Clicking this option will delete the currently selected 

component. 

Calculation Settings 

The “Calculation Settings” tab of the configuration window allows you to modify 

miscellaneous settings associated with calculations. 
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The "Calculation Settings" tab of the Diablo EZReporter configuration window 

Component Amount Precision 

Use this option to set the number of decimal places to round the component amount 

or mole percent values prior to their being used in calculations.  Component and 

related total amounts will also be displayed in the report using this number of 

decimal places. 

 

Important: Important:  The normalized mole% values will be rounded to the number of 

decimal places specified in this setting before they are used in any calculations.  In 

addition, if rounding causes the total normalized mole% not to sum to 100%, then a 

correction is made to the normalized mole% of the most concentrated component in 

the sample (usually methane in NGA applications) to force the total to 100%. 

 

Internal Standard Amount Mapping 

This is an advanced option that allows you to map the Internal Standard Amount 

from an analysis to the raw mole% of one of the components.  This means that you 

can enter a result from another analyzer (e.g. H2S from a Draeger tube) into the 

chromatography data system sequence, and have it automatically applied to the 

specified component without requiring reprocessing or prompting. 

 

Important: Note 1:  Some data systems will switch the ISTD Amount from 0 or blank to 1 in the 

sequence table.  Consequently, you may need to enter a very small non-zero number 

for 0 (for example 0.000001). 

Note 2:  There may be additional method settings required to enable this capability.  

Please see the EZReporter Quick Start Guide for your data system. 
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Report - Control 

The "Report" tab of the configuration dialog allows you to customize the printed 

report. 

 

The “Report Control” section of the "Report" Tab of the Diablo EZReporter Configuration 
Screen 

Report Control 

Check the “Print report for automatically processed results” box if you would 

like a report to be sent to the default printer when processing data automatically from 

a chromatography data system. 

By default, all components in the component table will be included in the report.  

Check “Report only components with amount > 0” if you would like components 

with a raw amount of 0 to be excluded from the component results in the report. 

Monitored parameters 

Check the “Print parameter report” option if you would like to have a monitored 

parameter report printed along with the standard results report.  If you also check the 

“Report only parameters with failed alarms” option, then only those parameters 

whose value has exceeded an enabled alarm limit will be included in the parameter 

report. 

Report Margins 

You can set the margins of the printed report in inches in order to make space for 

letterhead or logo, or to increase or decrease the number of lines printed on each 

page. 
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PDF File Control 

These settings allow an Adobe Acrobat, “PDF” version of the report to be saved to a 

specified folder when processing results automatically.  To enable this option check, 

“Save PDF file for automatically processed results”. 

Save PDF File to Folder:  Click the “Open” button to select the directory to 

which the “PDF” files will be saved. 

PDF File Name:  These options are used to specify the PDF file name.  You can 

choose to name the PDF file based on the name of the EZReporter data file (see the 

“Data Files” tab), or you can enter a “fixed” file name.  If you choose the first 

option, the PDF file will have the same base file name as the EZReporter data file.  

You can also have the export file named based on the sample name from the 

chromatography data system. 

Append Additional Text 

This option allows you to append additional custom text to the bottom of the report – 

below the total/summary results table.  You can either edit the file “additional.txt” by 

clicking the Notepad icon, or browse and select a different file containing the desired 

text.  You can also choose whether the text is left, center, or right justified on the 

report page. 

Note:  This additional text is only included in the printed report.  It is not displayed 

on screen. 

Report – Titles 

You can modify all of the titles, captions, and labels displayed on the report in the 

“Report Titles” tab. 

 
The “Titles” section of the "Report" Tab of the Diablo EZReporter Configuration Screen 
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Report - Customize 

 
The “Customize” section of the "Report" Tab of the Diablo EZReporter Configuration Screen 

The result table shown in the “Customize” tab of the Report configuration screen 

allows you to customize the viewed/printed report.  You can change the text of the 

labels that identify a result on the report, set the formatting of numeric results, and 

add or remove results from the report by checking or un-checking the checkbox in 

the “Report” column. 

Note that the “|” character is converted into a line break when the labels are rendered 

onto the report.  This is particularly useful for component results when you want to 

minimize the width of the component result column. 

Format 

You can set the numeric formatting for a result by entering a format string in the 

corresponding field.  Examples of common formatting strings are shown in the table 

below. 

Important:  The format of component and related total amount results is determined 

by the “Component Amount Precision” setting (see “Component Amount Precision” 

on page 22).  You are not able to customize the format of those results. 

 

Format String Result 

0 Will display all digits to the left of the decimal point and no digits to 

the right: 

The value 10000.2324 will be displayed as 10000 

The value 0.2324 will be displayed as 0 

0.00 Will display all digits to the left of the decimal point and two digits 

to the right of the decimal place: 

The value 232.4012 will be displayed as 232.40 

The value 232 will be displayed as 232.00 

0.0### Will display all digits to the left of the decimal place, and from 1 to 4 
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digits to the right of the decimal place: 

The value 232.4012 will be displayed as 232.4012 

The value 232.4 will be displayed as 232.4 

The value 232 will be displayed as 232.0 

Common numeric formatting strings. 

Context Menu 

If you right click anywhere on the report/result table, the following context menu 

options will pop up: 

Select all results:  Check all of the results currently displayed in the table. 

Select no results:  Uncheck all of the results currently displayed in the table. 

Select default results:  Check only the results that are included in the default 

configuration. 

Reset report labels to default values:  Resets all of the report labels to their original, 

default value. 

Data Files 

The settings in the "Data Files" tab of the configuration dialog allow you to 

customize how data files are handled. 

 

The "Data Files" Tab of the Diablo EZReporter Configuration Screen 

Default Data Directory 

Specify the directory into which you would like to save data files – use the "Browse" 

button to select or create the desired directory. 
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Automatic File Saving 

Check this box if you would like to have a data file created in the default data 

directory during automatic processing of data from a chromatography data system. 

There are two options available for naming the data files 

Use data system data file name 

If you choose this option, the data file will be named based on the source data file 

name generated by the chromatography data system.  The file will be named with the 

same base filename, but with the “.BTU” file extension instead of the “.DAT” file 

extension. 

Auto-Generate Data File Name 

  The data files are named using a Date + Time format: 

 YYYYMMDD-HHMMSS.BTU  

Where YYYYMMDD is the current date and HHMMSS is the current time (e.g. 

20050208-153423.BTU). 

Auto-Generated Data File Naming Options 

Check this box if you would like to have the sample name added to the Date+Time 

formatted file name during automatic processing (e.g. NGA Sample-20050208-

153423.BTU). 

Sample Name Options 

This option allows you to set whether the sample name is added before or after the 

file name.  Select “Before” (e.g. NGA Sample-20050208-153423.BTU) if you want 

the data files to sort alphabetically by sample name when you view the data file 

directory in Windows Explorer.  Select “After” (e.g. 20050208-153423-NGA 

Sample.BTU) if you want the data files to sort by the Date/Time. 

File Format 

This option sets whether the data files are saved using a Comma or a Tab as the 

delimiter character between fields in the file. 

Sample Info 

These options allow you to enable and configure custom sample information fields 

that can be used to report additional conditions like well number, pressure, 

temperature, etc.  They are simply a way for the user to enter additional custom 

information during an analysis, and have that information printed on reports and 

saved in the data and export files. 
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The "Sample Info" Tab of the Diablo EZReporter Configuration Screen 

Check the “Enable custom sample information fields” checkbox to enable the custom 

sample information fields.  Press the “Add” button to add a new sample information 

field, or the “Delete” button to delete the field that is currently selected.  The 

captions are displayed on the printed report, and when you are prompted to enter the 

associated custom sample information.  You can also specify whether the field is 

numeric. 

Default Value 

A default value can be specified for each of the custom sample information fields.  

The default value will be displayed automatically when the Sample Information 

dialog box is displayed.  However, if the “Recall” option is set and a previous value 

exists for the field, then the previous value will be displayed instead of the default 

value. 

Numeric Sample Information Fields 

If a sample information field is numeric, special numeric formatting and scaling can 

be applied to the value in the export file.  See “Data Export” on page 29 for more 

information. 

Recall Last Value 

Check the “Recall” check box if you would like the last value entered into this field 

to be recalled when the form is displayed. 

Report 

If the “Report” checkbox is checked, then the field will be displayed in the “Sample 

Information” section of the report.  If it is unchecked, then the field will not be added 

to the report.  
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Changing the order of Sample Information Fields 

The order of the fields in the sample information table is the order that they will be 

printed in the report and displayed in the sample information prompt.  You can easily 

rearrange the field order by first selecting a field's row in the table by left clicking on 

that row with the mouse.  Next, while the cursor is still pointing to that row, click 

and hold the right mouse button and drag the field to a new location in the table.  

The row being moved will be highlighted in red.  Release the right mouse button 

when the field is located at the desired position in the table. 

 

Important: Important:  Be careful rearranging the order of the Sample Information fields if you 

are using Export Templates that refer to Sample Information fields.  In those 

instances Sample Information fields are identified by their index, which is their order 

of in the sample information table.  If you rearrange the sample information table 

after you have set up an Export Template, it is possible that the wrong Sample 

Information field will be referenced. 

 

Entering custom sample information: 

If you have enabled custom sample information fields, and if at least one of the fields 

contains a caption, then “Manual Data Entry” dialog box will be displayed when 

automatically processing results from a chromatography data system.  This dialog 

box will display the caption(s) specified in the Sample Info configuration, and allow 

the associated custom sample information to be entered by the user.  Alternatively, 

you can manually enter the sample information using the “Tools > Edit Current Data 

Set…” menu option. 

 
The "Diablo EZReporter Manual Data Entry "window showing the custom sample information 
fields. 

Data Export 

The EZReporter software includes a flexible data export feature that allows you to 

create custom data export files in almost any format you might need.  An export 

template file defines the format of the export file. 
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Export Configuration Panel 

Export Options 

Check “Create export file for automatically processed results” if you want the results 

from a chromatography data system to be exported automatically when the data is 

processed by the EZReporter software. 

Check “Append results if export file already exists” if you want the exported results 

to be appended to any results that already exist in the specified export file.  If this 

option is unchecked, then existing results will be overwritten. 

Export Template File 

Click the “Open” button to specify the template file that will be used to create the 

export file.  Click the “Notepad” button to open the selected export template file in 

Windows Notepad for editing.  See “Export Template Format” in the Appendix on 

page 48 for information on creating and editing Export Template files.  Note that 

several example template files are included with the software in the application 

“Settings” folder. 

Export Directory 

Click the “Open” button to select the directory to which export files will be saved. 

Export File 

These options are used to specify the export file name.  You can choose to name the 

export file based on the name of the EZReporter data file (see the “Data Files” tab), 

or you can enter a “fixed” file name.  If you choose the first option, the export file 

will have the same base file name as the data file. 
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You can also have the export file named based on the sample name.  This allows 

results from replicate runs of the same sample to be added appended to the same 

export file even though the data file names are different. 

Export File Extension:  Enter the file extension to use for the export file into this 

text box field.  The default extension if this field is left blank is “txt”. 

Note:  if you enter a fixed export file name that already includes a file extension, it 

will take precedence over the entry in the Export File Extension field. 

Show Template Variables 

If you click this button, a table of supported template variables with descriptions will 

be displayed.  You can print this list by pressing the “Print” button. 

 

Hint: Hint:  If you double-click on a particular variable, it will be copied to the Windows 

clipboard so that you can paste it into a template file. 

 

 

 
EZReporter Template Variable Table 



 

32    Running the Software Standard Edition -  Diablo EZReporter Software 

Calculated Results 

Calculated results are based on custom formulas you enter using the “Formula 

Builder”.  The Formula Builder allows you to select from a list of available result 

variables and supported arithmetic operators to build a custom formula that will be 

evaluated to a numeric value when processing results.  The Calculated Result is then 

displayed in the Results Summary part of the report along with a descriptive caption 

that you also specify. 

Calculated Results can also be used as Monitored Parameters for alarming and trend 

plotting and both the caption and value can be specified in an Export Template and 

exported to a text file. 

 
The EZReporter Calculated Results configuration table 

Adding Calculated Results to the Configuration and Report 

To add a Calculated Result to the configuration and report: 

1. Click the “Add” button. 

2. In the new line that is added to the Calculated Results table, enter a caption 

that describes the result.  This caption will be displayed along with the 

calculated value in the “Results Summary” section of the report. 

3. Click the […] button that is visible when you click in the “Formula” cell to 

display the Calculated Result Formula Builder and create the custom 

formula. 

4. Check the “Report” checkbox if you want this Calculated Result displayed 

in the report. 

5. Enter the desired numeric format string for this result.  See “Format” on 

page 25 for information on specifying the numeric format. 
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Creating a Custom Formula using the Formula Builder 

You create a custom formula for a Calculated Result using the Formula Builder tool 

that is displayed by clicking the […] button when the cursor is in the Formula cell of 

the Calculated Results table. 

Formulas consist of Result Variables and arithmetic Operators (+,-,*, etc.).  Simply 

double click the desired Result Variable or Operator from the respective list and it 

will be inserted at the current cursor location in the “Current Formula” box.  See 

“Calculated Result Formula Builder Operators” on page 55 in the appendix for a 

description of supported operators. 

 
The EZReporter Custom Calculation Formula Builder 

If the Result Variable you have selected is a Component Result, you will also be 

prompted to select the desired component. 

 

 

IMPORTANT: Important:  If you have included any Component Variables in the custom formula, 

you should not change the order of components in the main Component Table.  

Component variables are linked to the specific component by the component 

number, which is based on the order they are displayed in the component table.  If 

you change the component order, it is possible that the formula will be linked to a 

different component than expected. 
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Once you have created the custom formula you can check that the syntax is valid by 

clicking the “Check Syntax” button.  If the formula syntax is invalid, an error 

message will be displayed: 

 

If the formula syntax is valid, the result of the calculation will be displayed.   Note 

that the result of the calculation will be 0 unless there is a current report with actual 

results displayed in the main EZReporter Sample Result window in which case it 

will use the actual result values in the calculation. 

 

Parameter Options 

The “Parameters” tab allows you to configure a list of component or calculated 

results that will be displayed in the “Parameter Monitor” window of the main 

software screen.  You can set both high and low alarm limits for these monitored 

parameters – if the parameter value exceeds either of these limits, the result will be 

displayed with a red background in the parameter table to alert you. 

 

 
The Parameter Monitoring configuration panel 

Options:  Clicking the “Option” button displays the Monitoring Options dialog 

box.  See “Setting Monitored Parameter Options” on page 35. 
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Add:  Clicking the “Add” button allows you to configure and add a new parameter 

to the monitored parameter table.  See “Adding or Editing Monitored Parameters” on 

page 37. 

Edit:  Clicking the “Edit” button allows you to edit the options for the parameter that 

is currently selected the parameter table.  You can also double-click the desired row 

in the table to edit a parameter’s options.  See “Adding or Editing Monitored 

Parameters” on page 37. 

Delete:  Clicking the “Delete” button will remove the selected parameter from the 

parameter table. 

Clear:  Clicking the “Clear” button will clear the parameter table. 

Undo:  Clicking the “Undo” button will restore the parameter table to the last saved 

configuration. 

Help:  Clicking the “Help” button displays context-sensitive help for this topic. 

Changing the Display Order of Parameters 

To rearrange the order of the parameters in the parameter table, first select the row of 

the parameter you want to move by left clicking on that row with the mouse.  Next, 

while the cursor is still pointing to that row, click and hold the right mouse button 

and drag the selected row to the desired new location in the table.  Release the right 

mouse button when the field is located at the desired position in the table. 

Cloning Parameters 

Right clicking on a parameter in the table displays a context menu that allows you to 

clone the properties of the selected parameter to a new parameter.  This allows you 

to create a new parameter quickly using an existing parameter as a template. 

Auto-add All Components 

Right clicking on a component parameter table displays a context menu that allows 

you to add the remaining components in the configuration to the parameter table 

using the selected component parameter as the template. 

Setting Monitored Parameter Options 

Click the “Options” button to set additional options for the Parameter Monitoring. 

Monitor Options Tab 
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Parameter Monitoring Options Dialog – Monitor Options Tab. 

Parameter Table Options 

Check the “Display alarm limits in parameter table” option if you would like to 

include the actual upper and lower alarm limits in the parameter table along with the 

parameter name and value.  This can be especially useful when using relative alarm 

limits so that you can see the actual calculated limits for each parameter. 

Parameter Display Font 

In the “Parameter Display Font” section, use the “Size” list box and “Bold” and/or 

“Italic” check boxes to set the desired font for the Monitor Table.  A preview of the 

font is displayed for you. 

 

History Plots Tab 

 
Parameter Monitoring Options Dialog – History Plots Tab 

Enable Parameter History Plots:  Check this box to enable history plots for the 

monitored parameters.  Note that this option will be set automatically if history plots 

are enabled for any of the individual parameters. 

X-Axis Data Source:  You can choose to plot the parameter values against a 

sequential data point/run number, the current time when the report/results are 

generated, or the injection date/time of the chromatographic run. 
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X-Axis Scroll Window: The X-Axis will automatically zoom to this time (in 

minutes) or data point window.  When new results are received, older data points 

outside this window will no longer be visible.  However, the entire history plot can 

be displayed at any time by clicking the “Zoom Full” button, or double-clicking on 

the plot window. 

Y-Axis Scaling:  You can choose to have the y-axis scale adjusted automatically so 

that the range includes only the data points that are visible in the current 

plot/window.  Alternatively, you can choose to have the y-axis scale adjusted so that 

it represents the full range of parameter values, including those outside the current 

plot/window. 

 

Important: Important Note:  If you have enabled either high or low alarm limits in the 

parameter configuration, then those limits will be displayed as red, dotted lines on 

the history plot.  Those alarm limits are included when determining the Y-axis range. 

 

Parameter Series Display Mode:  You can display each parameter history plot 

series either individually or with all series overlaid on the same axes. 

Adding or Editing Monitored Parameters 

Click the “Add” button to add a new monitored parameter or the “Edit” button to 

edit the monitored parameter currently selected in the parameter table (you can also 

double click the line in the table that you want to edit).  You can also clear the 

current table by pressing the “Clear” button, or undo any changes you have made to 

the table by pressing the “Undo” button. 

 
The Edit Monitored Parameter dialog 

Parameter:  Select the parameter that you want to monitor from this list box.  If 

you select a parameter that is derived from a component result (component amount, 
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for example), then you will also need to specify the corresponding component from 

the component list box. 

Note that if the NGA Module is active, the parameter list will include a number of 

different NGA-related result parameters.  If the NGA module is not active, only 

chromatographic parameters like retention time, peak area, and amount will be listed. 

Component:  If you select a parameter that is derived from a component result 

(component amount, for example), then you will also need to specify the 

corresponding component from the component list box. 

Format:  You can set the numeric formatting for the displayed parameter value by 

entering a format string in this text box.  Examples of common formatting strings are 

shown in the table below. 

 

Format String Result 

0 Will display all digits to the left of the decimal point and no digits to 

the right: 

The value 10000.2324 will be displayed as 10000 

The value 0.2324 will be displayed as 0 

0.00 Will display all digits to the left of the decimal point and two digits 

to the right of the decimal place: 

The value 232.4012 will be displayed as 232.40 

The value 232 will be displayed as 232.00 

0.0### Will display all digits to the left of the decimal place, and from 1 to 4 

digits to the right of the decimal place: 

The value 232.4012 will be displayed as 232.4012 

The value 232.4 will be displayed as 232.4 

The value 232 will be displayed as 232.0 

Common numeric formatting strings. 

Default:  If you click the “Default” button, the default formatting string for this type 

of parameter will be copied into the format text box for you. 

Display Name:  The text entered into the “Display Name” text box will be 

displayed for this parameter in the Monitor Table.  You can click the [<] button to 

copy text from the parameter and component (if appropriate) list boxes into the text 

box. 

Enable History Plot for this parameter:  If you check this box, then the value 

of this monitored parameter will be plotted in the Parameter History display. 

Parameter Alarms 

You can enable both high and/or low parameter alarms by checking either one or 

both of these check boxes and selecting the desired alarm type/limit. 
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The “Alarms” tab of the Edit Monitored Parameter window showing both High and Low 

Alarms enabled. 

If an alarm is enabled and the parameter value exceeds the specified limit, the result 

will be displayed with a red background in the Monitor Table to alert you.  

Conversely, if the alarm is enabled and the parameter value does not exceed the 

limit, the result is displayed with a green background. 
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The EZReporter software supports several types of Alarms, including fixed alarm 

limits, and relative alarm limits.  Use the “Alarm type” list box to select the type of 

alarm limits to use for the parameter. 

Fixed Alarm Limits 

With the “Fixed alarm limits” alarm type you simply enter the upper and lower 

values for the alarm limits. 

 
The “Alarms” tab of the Edit Monitored Parameter window showing the settings for fixed 
upper and lower alarm limits. 

Relative Alarm Limits 

With “Relative alarm limits” you must enter an alarm value and the limits are 

calculated relative to that value.  You can specify whether you want the limits 

calculated as a percent relative to the Value (Value +/- %Limit of the Value) or use 

absolute limits (Value +/- Limit). 
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The “Alarms” tab of the Edit Monitored Parameter window showing the settings for relative 
alarm limits. 

Text Alarms 

Text alarms are available when the chosen parameter is a non-numeric, text result 

like “Sample Name”.  If you enable the Text Alarm, the alarm will be triggered when 

the parameter text matches the alarm condition defined by the “Alarm Text” and the 

“Alarm when” setting.  The comparison is not case sensitive. 

 
The “Text Alarms” tab of the Edit Monitored Parameter window showing the settings for a 
Text Alarm. 
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Sample History Alarm Limits 

 

Using Monitored Parameters and History Plots 

The Parameter Monitor 

Monitored parameters are displayed in a table on the “Parameter Monitor” tab of the 

main software screen.  The parameter table displays the results for monitored 

parameters from the last analysis or last data file loaded. 

If either the high or low alarm is enabled for any of the monitored parameters, then 

the background color of the parameter value will be either red or green depending on 

whether the actual value exceeds the enabled alarm limit. 

 

 
The EZReporter Parameter Monitor Window 

Parameter History 

Historical values of monitored parameters can be plotted in the Parameter History 

window. 
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In order to display the parameter history window, you must enable history plots for 

each individual parameter whose results you want to plot.  See “Parameter Options” 

on page 34” for more information. 

The individual parameter history plots and summary statistics are displayed by 

clicking on the desired parameter display name in the parameter list.  If either high or 

low alarm limits have been enabled for a parameter, then the parameter name will be 

displayed with either a red or green background to indicate whether the current 

parameter value has exceeded an alarm limit (red background) or not (green 

background).  In addition, the alarm limit is displayed a s red, dotted line on the 

history plot. 

 
The “Parameter History” tab on the main screen of the Diablo EZReporter 

Reset History:  Click the “Reset History” button to clear and reset the history plot 

and summary statistics for all plotted parameters. 

Zoom Full:  Click the “Zoom Full” button to expand/contract the X and Y axes of 

the history plot to display the entire plot.  Double-clicking in the history plot window 

performs the same function. 

Options:  Click the “Options” button to change the X-axis scroll window or Y-axis 

scaling mode: 
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Copy:  Click the “Copy” button to copy the currently displayed trend plot to the 

Windows clipboard. 

Print:  Click the “Print button to print the currently displayed history plot and 

summary statistics. 

Export:  Click the “Export” button to export the history results for all components 

to a comma-delimited text file. 

Help:  Click the “Help” button to display context-sensitive help for this topic. 

Data Processing and Reporting 

Manual Data Processing and Reporting 

It is possible to enter component mole% values manually and calculate results based 

on those values.  Select "New Data Set…" from the "file" menu.  Any existing 

results will be cleared from the main screen, and you will be presented with the 

Manual Data Entry dialog.  Enter the mole% values into the component table, and 

optionally a sample name, user name, and comments, and then press the "Process" 

button to perform the calculations. 
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Manual Data Entry Dialog Box 

Important: Important:  Make sure to save these results to an EZReporter data file (select "Save 

Data Set As…" from the "File" menu) if you want to be able to recall the data at a 

later time.  You can print a report by selecting "Print > Report" from the "File" 

menu. 

 

You can re-edit the data you entered manually by selecting "Edit Current Data 

Set…" from the "Tools" menu.  Note however, that for purposes of data integrity, 

this option is disabled for data sets from a chromatography data system that were 

processed automatically. 

Automatic Data Processing and Reporting 

Refer to the EZReporter Quick Start Guide for your chromatography data system for 

instructions on how to configure the data system to send results automatically to 

EZReporter for data processing and reporting. 

Sample-Specific Configuration Processing 

Sample-Specific Configuration Processing allows you to use different EZReporter 

configuration files based on the sample name when automatically processing results 

from a supported data system. 

To configure this feature, select the “File > Sample-Specific Configurations…” 

menu option. 
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Check or uncheck the “Enable Sample-Specific Processing” checkbox to enable or 

disable this feature.  If enabled during automatic processing of results from one of 

the supported data systems, the sample name from the data system is compared to the 

sample names in the table.  If a match is found, the corresponding configuration file 

is loaded prior to processing the sample results. 

Simply click the “Add” button to add a sample name and the corresponding 

configuration file that should be used for that type of sample.  You can include ‘*’ 

and ‘?’ wildcard characters in the sample name.  The ‘*’ character will match any 

character or characters in that position, while the ‘?’ matches a single character in 

that position. 

Note:  If a sample name matches both a fixed sample name (“Air Sample”) and a 

wildcard sample name (“Air*”), then the configuration file specified for the fixed 

sample name will be used.  If a sample name matches more than one wildcard entry, 

then the configuration file for the first entry alphabetically will be used. 

The mandatory “Default” configuration file is selected whenever a sample name 

doesn’t match any of the sample names in the table. 
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Appendix 

EZReporter Data File Format 

EZReporter data files are comma-delimited text files that can be imported into LIMS 

or process data systems.  An example file is listed below. 

 

Hint: Hint: Although the EZReporter data files are text files that can be used directly to 

send results to other customers or databases, Export files are a much better, more 

flexible way to do this.  See “Data Export” on page 29 for more information on 

Export Templates and Export Files. 

 

 

SampleName,"GPA 2172-96 Example Calculation" 

MethodName,"" 

UserName,"" 

Comments,"Gas properties at 60 Deg. F and 14.696 psia 

(Gas Analysis on Dry Basis)" 

InjectionTime,"" 

SettingsFile,"C:\Program Files\ Diablo 

EZReporter\Settings\GPA 2172-96 Wet.cfg" 

ProcessMode,3 

DataSource,1 

Instrument,"" 

SampleInfo1,"1456" (optional) 

SampleInfo2,"82" (optional) 

SampleInfo3,"" (optional) 

SampleInfo4,"" (optional) 

,,"Component","Ret.Time","Peak Area","Unnormalized 

Mole%","Normalized Mole%","Gross Heating Value","Molar 

Mass Ratio","Summation Factor" 

Component,1,"Helium",0.000,0,0.03,0.03,0,0.00004146,0 
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Component,2,"Nitrogen",0.000,0,0.32,0.32,0,0.003095136,0

.00001408 

Component,3,"Carbon 

Dioxide",0.000,0,2.02,2.02,0,0.03069592,0.00039794 

Component,4,"Methane",0.000,0,83.02,83.02,838.502,0.4598

64384,0.00963032 

Component,5,"Ethane",0.000,0,7.45,7.45,131.84265,0.07734

59,0.00178055 

Component,6,"Propane",0.000,0,4.39,4.39,110.45679,0.0668

4214,0.00151016 

Component,7,"i-

Butane",0.000,0,0.83,0.83,26.99077,0.01665644,0.00038014 

Component,8,"n-

Butane",0.000,0,1.08,1.08,35.23284,0.02167344,0.00051624 

Component,9,"i-

Pentane",0.000,0,0.31,0.31,12.40279,0.00772272,0.0001801

1 

Component,10,"n-

Pentane",0.000,0,0.25,0.25,10.02225,0.006228,0.00015775 

Component,11,"n-

Hexane",0.000,0,0.3,0.3,14.2677,0.0089265,0.0002406 

SumHV,1179.71779 

SumMolarMass,0.69909204 

SumZ,0.01480789 

RawTotalMolePct,100 

PressureBase,14.696 

WaterMoleFractionSat,1.74442025040827E-02 

GrossHeatingValueIdealDry,1179.71779 

GrossHeatingValueRealDry,1183.53165556816 

GrossHeatingValueIdealSat,1159.13855397357 

GrossHeatingValueRealSat,1163.31848048984 

RealRelativeDensityDry,0.701094431772844 

RealRelativeDensitySat,0.700006424492229 

GasCompressibilityFactorDry,0.996777555082519 

GasCompressibilityFactorSat,0.996406894082425 

Export Template Format 

Export templates are plain-text files with a “.btx” file extension that are used to 

define how results will be saved to the text files created by the export feature of the 

EZReporter software.  Any text editor like Windows Notepad can edit export 
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template files.  However, make sure they are saved with the “.BTX” file extension 

(Notepad will sometimes append a “.TXT” file extension to the end of the “.BTX” 

extension.) 

The export function will replace any "variables" it finds within the export template 

file with the current value of the variable.  Variables are pre-defined names enclosed 

between braces: {VariableName}. 

Note:  The template examples shown below are included in the template file, 

“Example Export Template.btx”. 

 

Any other text that is present in the template file will be exported "as is" unless it is 

part of a comment or other special template section. 

 

{StartComment} 

Any text present between {StartComment} and 

{EndComment} will not be saved to the export file.  

Comments can be used to annotate the template file. 

{EndComment} 

 

The lines between StartHeader and EndHeader will only be saved to a new export 

file.  They will not be saved when new results are appended to an existing export 

file. This can be used to create a column header for a summary list of results from 

multiple runs, for example. 

 

{StartHeader} 

Date, Name, Ret. Time, Area, Mole% 

{EndHeader} 

 

"DecimalPlaces" is a special variable used to set the number of decimal places to 

include for calculated results (4 places in this example).  It affects the results that are 

exported after its place in the template.  Note that the default value is the number of 

decimal places specified in the Data Files configuration. 

Note:  It is generally best to change the number of decimal places to report using the 

option in the Data Files section of the EZReporter configuration editor rather than 

the “Decimal Places” variable. 

 

{DecimalPlaces,4} 

 

To create a comma-delimited export file, simply include commas between the fields 

you wish to separate.  In addition, if you want quotation marks to enclose text fields, 

simply include them in the template as shown below. 

 

"CurrentDate", "{Now}" 
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"SampleName", "{SampleName}" 

"UserName", "{UserName}" 

 

To create a tab-delimited file, simply use the tab key on your keyboard, or include 

the special tab variable, "Tab", between the fields you wish to separate as shown 

below. 

 

CurrentDate {Now} 

SampleName {SampleName} 

UserName {UserName} 

 

or 

 

MethodName{Tab}{MethodName} 

SettingsFile{Tab}{SettingsFile} 

InjectionTime{Tab}{InjectionTime} 

 

You can use the special component loop to print the component-specific results 

(Name, Mole%, Area, etc.) for all of the components in the current configuration.  

The components are exported in the same order that they appear in the configuration 

editor. 

 

{StartCompLoop} 

{CompName},{CompRT},{CompArea},{CompNormMolePct} 

{EndCompLoop} 

 

If instead, you want to export the results for a specific component, simply include the 

component number in the variable as shown below. Components are numbered in the 

order they appear in the configuration editor, starting with 1 for the first component. 

 

Component 1 Name:  {CompName,1} 

Component 1 Mole%: {CompNormMolePct,1} 

 

You can use the special line continuation variable, "_", to force the next line in the 

template to be appended to the current line instead of in a new line: 

 

{CompName,1},{_} 

{CompName,2},{_} 
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{CompName,3} 

 

Line continuation is most useful in instances where you want all of the results to 

appear in a single line.  For example, you would use the line continuation in a 

component loop to create a summary export file in which each line corresponds to a 

single run. 

 

{StartCompLoop} 

{CompName},{CompRT},{CompArea},{CompNormMolePct},{_} 

{EndCompLoop} 

Summary of Export Template Variables 

You can view a list of the variables that are supported by Export Templates at any 

time by selecting either the “Tools > Show Export Template Variables…” menu 

option, or by clicking on the “Show” button in the Export section of the 

configuration editor.   

 
EZReporter Template Variable Table 

Hint: Hint:  If you double-click on a particular variable in the table, it will be copied to the 

Windows clipboard so that you can paste it into a template file. 
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Export Variable Format Strings and Scale Factors 

Optional formatting strings and scaling factors can be specified for export variables 

to increase flexibility. 

 

Important: Important:  The use of formatting strings and scaling factors is an advanced feature 

and should only be utilized when export file requirements dictate. 

 

The export variable syntax is shown below: 

{VariableName, [PARAMETER], [FORMAT], [SCALEFACTOR]} 

VariableName:  The name of the variable. 

[PARAMETER]:  An optional parameter value that is required for some variables. 

[FORMAT]:  A special format string that instructs the export engine on how to 

format the variable value before writing it to the export file. 

[SCALEFACTOR]:  If the variable is numeric, it will be multiplied by the specified 

scaling factor prior to formatting and writing the result to the export file. 

The following table describes the special characters used to make up a format string. 

 

Format 
Character 

Description 

Numeric Formatting 

0 Digit placeholder. Display a digit or a zero. If the variable has a digit in 

the position where the 0 appears in the format string, display it; otherwise, 
display a zero in that position. 

# Digit placeholder. Display a digit or nothing. If the variable has a digit in 

the position where the # appears in the format string, display it; otherwise, 

display nothing in that position. 

. Decimal placeholder.  The decimal placeholder determines how many 

digits are displayed to the left and right of the decimal separator. If the 

format expression contains only number signs to the left of this symbol, 

numbers smaller than 1 begin with a decimal separator. To display a 

leading zero displayed with fractional numbers, use 0 as the first digit 

placeholder to the left of the decimal separator. 

Text String Formatting 

@ Character placeholder. Display a character or a space. If the string has a 

character in the position where the “at” symbol (@) appears in the format 
string, display it; otherwise, display a space in that position. 

& Character placeholder. Display a character or nothing. If the string has a 

character in the position where the ampersand (&) appears, display it; 
otherwise, display nothing. 

Date Formatting 

d Display the day as a number without a leading zero (1 – 31). 

dd Display the day as a number with a leading zero (01 – 31). 

m Display the month as a number without a leading zero (1 – 12). 

mm Display the month as a number with a leading zero (01 – 12). 

yy Display the year as a 2-digit number (00 – 99). 

yyyy Display the year as a 4-digit number (100 – 9999). 
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Time Formatting 

h Display the hour as a number without leading zeros (0 – 23). 

Hh Display the hour as a number with leading zeros (00 – 23). 

N Display the minute as a number without leading zeros (0 – 59). 

Nn Display the minute as a number with leading zeros (00 – 59). 

S Display the second as a number without leading zeros (0 – 59). 

Ss Display the second as a number with leading zeros (00 – 59). 

The following table shows a few examples of format strings and scaling factors. 

 

Variable Variable Value Value Exported 

{CompRawMolePct,1,0.000} 1.523446 1.523 

{CompRawMolePct,1,0.000} 85.67234 85.672 

{CompRawMolePct,1,00000,1000} 85.67234 85672 

{CompArea,2,00000000} 1234 00001234 

{InjectionTime} 10/12/2004 1:08:13 PM 10/12/2004 1:08:13 PM 

{InjectionTime,,mmddyyyy} 10/12/2004 1:08:13 PM 10122004 

{InjectionTime,,HhNn} 10/12/2004 1:08:13 PM 2013 

{SampleName,,@@@@@@@@} Sample Name Sample N 

{SampleName,,@@@@@@@@} RC1 RC1***** 

 * = a space character 

Full List of Export Template Variables 

The following table lists all of the variables that are supported by EZReporter’s 

Export Templates. 

 

Hint: Hint:  The most up to date list of export template variables can always be viewed 

and printed by clicking the “Tools > Show Export Template Variables…” menu 

option. 

 

 

Export Variable Export Variable Description 

Component Result Variables 

CompNum The current component number being 

processed in a component loop. 

CompName The name of the component. 

CompRT The retention time of the component as 

reported by the data system. 

CompArea The integrated peak area of the 

component as reported by the data 

system. 

CompRawAmount The concentration of the component as 

reported by the data system. 

CompNormAmount The normalized amount of the component 

calculated by normalizing all of the raw 
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component concentrations to 100%.  For 

NGA applications this is the dry 

normalized mole% (water content 

exlcuded). 

Total/Summary Result Variables 

TotalRawAmount The total raw amount, including water if 

it has been entered. 

TotalNormAmount The total normalized amount (should 

always be 100%) 

Sample Information and Header Variables 

SampleName The sample name as reported by the data 

system. 

UserName The user or operator name as reported by 

the data system. 

Comments Additional Sample Information or Sample 

Notes as reported by the data system. 

MethodName The method used for acquisition by the 

data system. 

InjectionTime The date and time of the injection as 

reported by the data system. 

ReportDate The date and time that the results were 

calculated and reported. 

SettingsFile The EZReporter settings/configuration 

file used to calculate the results. 

SourceDataFileName The file name of the source data file used 

for acquisition as reported by the data 

system. 

DataFile The data file to which the EZReporter 

results were saved. 

Instrument The name of the instrument used for 

acquisition as reported by the data 

system. 

ExportFile The file name of the export file. 

ExportTemplate The file name of the export template used 

to create the export file. 

ExportDirectory The directory in which the export file is 

saved. 

EZReporterVersion The EZReporter version number. 

SampleInfo The value of the custom sample 

information field as entered by the user.  

Usage: {SampleInfo, 1} is the value of 

custom sample information field #1. 

SampleInfoCaption The caption for the custom sample 

information field as set in the 

configuration file.  Usage: 

{SampleInfoCaption, 1} is the caption 

associated with custom sample 

information field #1. 

Tab The ASCII \"tab\" character. 

Now The current date and time as reported by 

the operating system 

StartCompLoop Start a component processing loop.  All 

template lines between {StartCompLoop} 
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and {EndCompLoop} will be repeated 

once for each component in the 

configuration.  Use the component loop to 

report component-specific results. 

EndCompLoop End a component processing loop (see 

{StartCompLoop}) 

StartHeader All template lines between {StartHeader} 

and {EndHeader} will only be exported 

the first time an export file is written.  

The header lines will not be written when 

additional results are appended to an 

existing export file. 

EndHeader See {StartHeader} 

StartComment Any text between {StartComment} and 

{EndComment} will not be exported.  

Use to annotate your template file. 

EndComment See {StartComment} 

UCase Place on a line by itself to convert all 

subsequent export lines to upper case. 

LCase Place on a line by itself to convert all 

subsequent export lines to lower case. 

NoCase Place on a line by itself to report all 

subsequent export lines in their original 

case. 

DecimalPlaces Place on a line by itself to set the number 

of decimal places that will be reported for 

calculated numeric results.  The default 

value is the number of decimal places 

specified in the Data Files configuration. 

Usage: {DecimalPlaces,3}, sets the 

number of decimal places reported to 3. 

_ Line continuation variable placed at the 

end of a line to force the next line in the 

template to be appended to the current 

line instead of to a new line. 

Calculated Result Formula Builder Operators 

The following table lists the arithmetic operators that can be used along with Result 

Variables to create a Calculated Result custom formula using the Formula Builder 

tool.  See “Creating a Custom Formula using the Formula Builder” on page 33 for 

more information on custom formulas. 

 

Operator / Function Description Note 

+ addition   

- subtraction   

* multiplication   

/ division 35/4 = 8.75 
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Operator / Function Description Note 

% percentage 35% = 0.35 

\ integer division 35\4 = 8 

^ raise to power 3^1.8 = 7.22467405584208  (°) 

>  greater than return 1 (true)   0 (false) 

>= equal or greater than return 1 (true)   0 (false) 

<  less than return 1 (true)   0 (false) 

<= equal or less than return 1 (true)   0 (false) 

= equal return 1 (true)   0 (false) 

<>  not equal return 1 (true)   0 (false) 

tan(x) tangent 

argument (in radians)  x k*/2  

with k =  1,  2… 

atn(x) inverse tangent atn(pi/4) = 1 

abs(x) absolute value abs(-5)= 5 

sin(x) sin argument in radians 

cos(x) cosine argument in radians 

exp(x) exponential exp(1) = 2.71828182845905 

log(x) logarithm natural argument x>0 

logN(x,n) N-base logarithm logN(16,2) = 4 

sqr(x) square root 
sqr(2) =1.4142135623731,  also 
2^(1/2) 

int(x) integer part int(-3.8) = −4 

fix(x) integer part fix(-3.8) = 3 

dec(x) decimal part dec(-3.8) = -0.8 

rnd(x) random 
returns a random number 
between x and 0 

sgn(x) sign 
returns 1 if x >0 , 0 if x=0, -1 if 
x<0 

min(a,b,...) minimum min(13,24) = 13 

max(a,b,...) maximum max(13,24) = 24 

round(x,d) 
round a number with d 

decimal round(1.35712, 2) = 1.36   

Sum(a,b,...) Sum sum(8,9,12,9,7,10) = 55 

Mean(a,b,...) Arithmetic mean 
mean(8,9,12,9,7,10) = 
9.16666666666667 
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Operator / Function Description Note 

Meanq(a,b,...) Quadratic mean 
meanq(8,9,12,9,7,10) = 
9.30053761886914 

Meang(a,b,...) Arithmetic mean 
meang(8,9,12,9,7,10) = 
9.03598945281812 

Var(a,b,...) Variance 
var(1,2,3,4,5,6,7) = 
4.66666666666667 

Varp(a,b,...) Variance pop. varp(1,2,3,4,5,6,7) = 4 

Stdev(a,b,...) Standard deviation 
Stdev(1,2,3,4,5,6,7) = 
2.16024689946929 

Stdevp(a,b,...) Standard deviation pop. Stdevp(1,2,3,4,5,6,7) = 2 

 





 

Standard Edition -  Diablo EZReporter Software Index    59 

Index 

A 

Activating your License 6 

Adding Calculated Results to the Configuration and 

Report 32 

Adding new components 20 

Adding or Editing Monitored Parameters 37 

Alarm 2, 10, 34, 37, 38, 42, 43 

Append Additional Text 24 

Appendix 47 

Auto-add All Components 35 

Auto-Generated Data File Naming Options 27 

Automatic Data Processing and Reporting 45 

Automatic file saving 16, 27 

C 

Calculated Result Formula Builder Operators 55 

Calculated Results 32 

Calculation Settings 21 

Changing the component order 21 

Changing the Display Order of Parameters 35 

Changing the order of Sample Information Fields 29 

Clearing the table 21 

Cloning Parameters 35 

Component Amount Precision 22 

Component Name 20 

Component Summary 10 

Component Table Context Menu 21 

Components 19 

Configuring the Base Software Module 19 

Context Menu 26 

Creating a Custom Formula using the Formula Builder 

33 

Customizing the Report 10 

D 

Data Export 29 

Data Files 26 

Data Processing and Reporting 44 

Default Data Directory 26 

Default Value 28 

Deleting existing components 20 

E 

Entering custom sample information: 29 

Export Directory 30 

Export File 30 

Export Options 30 

Export Template File 30 

Export Template Format 48 

Export Variable Format Strings and Scale Factors 52 

EZReporter Data File Format 47 

EZReporter Software Overview 1 

F 

File Format 27 

File Menu 17 

File Naming Options 16 

Fixed Alarm Limits 40 

Format 25 

Full List of Export Template Variables 53 

G 

Getting Started 9 

Gross Heating Value 3, 47 

H 

Help Menu 18 

History Plot 18, 38 

I 

Installing the Software 4 

Internal Standard Amount Mapping 22 

Introduction 1 

L 

Load and Edit the Configuration File 12 

M 

Managing Configuration Files 19 

Manual Amount/Mole% Entry 20 

Manual Data Processing and Reporting 44 

Molar Mass Ratio 3, 47 

Monitored parameters 23 

N 

Notes for BTU Calculator Users 4 



 

60    Index Standard Edition -  Diablo EZReporter Software 

Numeric Sample Information Fields 28 

P 

Parameter Alarms 38 

Parameter History 42 

Parameter Options 34 

PDF File Control 24 

Pressure Base 13, 14, 15 

Q 

Quick Start Instructions 12 

R 

Real Relative Density 3 

Recall Last Value 28 

Relative Alarm Limits 40 

Report 28 

Report - Control 23 

Report - Customize 25 

Report - Titles 24 

Report Control 23 

Report Margins 23 

Results Summary 10 

Running the Software 17 

S 

Sample History Alarm Limits 42 

Sample Info 27 

Sample Information 9 

Sample Name Options 27 

Sample-Specific Configuration Processing 45 

Set the Data File Preferences 16 

Set the Report Preferences 16 

Set up your Chromatography Data System 16 

Setting Monitored Parameter Options 35 

Show Template Variables 31 

Software License and Registration 5 

Summary of Export Template Variables 51 

Summation Factor 3, 47 

System Requirements 4 

T 

Technical Support 6 

Text Alarms 41 

The Main Menu 17 

The Parameter History Window 11 

The Parameter Monitor 42 

The Parameter Monitor Window 10 

The Sample Results Window 9 

Tools Menu 18 

U 

Undoing changes to the component list 21 

Upgrading from the Diablo BTU Calculator Software 5 

Using Monitored Parameters and History Plots 42 

V 

Volume Factor 3 

 

 


	Diablo Analytical EZReporter Software
	Introduction
	EZReporter Software Overview
	Notes for BTU Calculator Users

	System Requirements
	Installing the Software
	Upgrading from the Diablo BTU Calculator Software

	Software License and Registration
	Activating your License

	Technical Support

	Getting Started
	The Sample Results Window
	Sample Information
	Component Summary
	Results Summary
	Customizing the Report

	The Parameter Monitor Window
	The Parameter History Window
	Quick Start Instructions
	Load and Edit the Configuration File
	Set the Report Preferences
	Set the Data File Preferences
	Automatic file saving
	File Naming Options

	Set up your Chromatography Data System


	Running the Software
	The Main Menu
	File Menu
	Tools Menu
	Help Menu

	Configuring the Base Software Module
	Managing Configuration Files
	Components
	Component Name
	Manual Amount/Mole% Entry
	Adding new components
	Deleting existing components
	Changing the component order
	Clearing the table
	Undoing changes to the component list
	Component Table Context Menu

	Calculation Settings
	Component Amount Precision
	Internal Standard Amount Mapping

	Report - Control
	Report Control
	Monitored parameters
	Report Margins
	PDF File Control
	Append Additional Text

	Report – Titles
	Report - Customize
	Format
	Context Menu

	Data Files
	Default Data Directory
	Automatic File Saving
	Auto-Generated Data File Naming Options
	Sample Name Options
	File Format

	Sample Info
	Default Value
	Numeric Sample Information Fields
	Recall Last Value
	Report
	Changing the order of Sample Information Fields
	Entering custom sample information:

	Data Export
	Export Options
	Export Template File
	Export Directory
	Export File
	Show Template Variables

	Calculated Results
	Adding Calculated Results to the Configuration and Report
	Creating a Custom Formula using the Formula Builder

	Parameter Options
	Changing the Display Order of Parameters
	Cloning Parameters
	Auto-add All Components

	Setting Monitored Parameter Options
	Adding or Editing Monitored Parameters
	Parameter Alarms
	Fixed Alarm Limits
	Relative Alarm Limits
	Text Alarms
	Sample History Alarm Limits


	Using Monitored Parameters and History Plots
	The Parameter Monitor
	Parameter History

	Data Processing and Reporting
	Manual Data Processing and Reporting
	Automatic Data Processing and Reporting
	Sample-Specific Configuration Processing


	Appendix
	EZReporter Data File Format
	Export Template Format
	Summary of Export Template Variables
	Export Variable Format Strings and Scale Factors
	Full List of Export Template Variables


	Calculated Result Formula Builder Operators

	Index

